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Abstract

A new color space known as Reference Output Medium Metric RGB (ROMM RGB) is
defined. This color space is intended to be used for manipulating images that exist in a
rendered image state. This color space was chosen to provide a large enough color gamut
to encompass most common output devices, and is defined in a way that is tightly linked
to the ICC profile connection space (PCS). Examples of manipulations that might be
applied in this color space include scene balance algorithms, manual
color/density/contrast/ tone scale adjustments, red-eye correction, and dust/scratch
removal. The color space is also appropriate for archiving and/or interchanging rendered
images. 8-bit, 12-bit and 16-bit versions of this color space are defined.

I. Introduction

In digital imaging systems, most images exist in color spaces that are directly tied to
the color of a desired output image. Examples of common color spaces that are used
include scanner RGB, video RGB, and CMYK. However, these color spaces are device-
dependent in the sense that the color values are associated with an actual perceived color
only in the context of the characteristics of the device on which the image is displayed or
scanned.

On the other hand, device-independent color spaces are designed to describe the color
that is perceived by a human observer. These color spaces are generally based on the
system developed by the Commission International de l’Eclairage (CIE). Examples of
device-independent color spaces include XYZ tristimulus values, and CIELAB. It should
be noted that the specification of a color value in a device-independent color space does
not fully specify color appearance unless the viewing conditions are known (i.e., two
patches with identical tristimulus values can have very different color appearance
depending on the conditions under which they are viewed).

The fact that images exist in many device-dependent color spaces significantly
complicates the development of software that uses and manipulates images. For example,
an algorithm that works in one color space might not have the expected behavior in
another color space. This has led many people to advocate the use of a standard color
space for the storage and manipulation of digital images. Generally, these proposals have
involved specifying some particular device-dependent color space to be a “standard.”
Examples of these color spaces include SWOP CMYK and sRGB.

One significant problem with specifying a particular device-dependent color space as
the standard color space is that it will necessarily limit the color gamut and dynamic
range of an image to that of the specific output device. For example, most color printers
have very different color gamuts than CRT video displays. Therefore, using sRGB (which
is basically a particular video CRT model) as a standard color space would necessarily
involve clipping many colors that could be produced on the final output printer to the
CRT gamut.
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The International Color Consortium (ICC) has defined a Profile Connection Space
(PCS) that comprises a device-independent color encoding that can be used to explicitly
specify the color of an image with respect to a reference viewing environment. Device
profiles can be used in a color management system to relate the device-dependent code
values of some input images to the corresponding color values in the PCS, and from there
to the device-dependent output color values appropriate for a specific output device. It
could be argued that the PCS could serve as the standard color space we are looking for.
However, it was never intended that the PCS be used to directly store or manipulate
images. Rather, it was simply intended to be a color space where profiles could be joined
to form complete color transforms. Neither the CIELAB nor the XYZ color encodings
supported for the PCS are particularly well-suited for many common kinds of image
manipulations.

It is therefore desirable to define a new standard large gamut color space that can be
used for storing and/or manipulating color images. The color space should have a number
of characteristics:

• It should be tightly coupled with the ICC Profile Connection Space.
• The transform to/from PCS should be relatively simple.
• The transform to/from video RGB should be relatively simple.
• The color gamut should be large enough to encompass most common output devices.
• The Color space should be appropriate for common image manipulations such as tone

scale modifications, sharpening, etc.
• It should be easily extensible to different bit-precisions.

These criteria are all met by the Reference Output Medium Metric RGB (ROMM RGB)
color space that will be described in the next section.

It should be noted that the ROMM RGB color space is designed to be used for
rendered output images. This is evidenced by the fact that it is tightly coupled with the
ICC PCS, which implicitly assumes the image is reflection-print-like, and is viewed in a
reflection print viewing environment. Rendered output images should be distinguished
from images that are intended to be an encoding of the colorimetry of an original scene.
Color spaces, such as ROMM RGB, which are intended to be used for encoding rendered
output images, would be inappropriate for use in encoding original scene images. Rather,
a color space that can be directly related to the color of an original scene should be used.
The Kodak PhotoYCC Color Interchange Space is one example of a color space of this
type.

Many fundamental differences exist between images that are representations of an
original scene, and images that are a representation of a rendered image. But the most
significant difference is related to the dynamic range of an original scene relative to the
dynamic range of a reflection print. A scene color space, such as the Kodak PhotoYCC
Color Interchange Space, must be able to encode the larger dynamic range associated
with scenes. Before converting an image in a scene color space to ROMM RGB, it is first
necessary to determine the desired rendered output image colorimetry using some sort of
tone/color reproduction aims. Note that this process necessarily involves discarding
and/or compressing some of the information in the original scene encoding to fit the
image within the smaller dynamic range of the rendered image encoding. Therefore, it
will sometimes be desirable to apply some manipulations to the image before it is
converted to a rendered image encoding such as ROMM RGB. For example, if an image
needs to be darkened, there would be an advantage to performing this operation before
converting the image to an output-rendered representation. This is because much of the
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highlight information that could be used to darken the image will be lost during the
conversion process.

Since one of the requirements for ROMM RGB is that it be tightly coupled to the ICC
Profile Connection Space (PCS), it is appropriate to review the important features of this
space. Color values in the PCS represent the CIE colorimetry of an image, which will
produce the desired color appearance when viewed in a reference viewing environment.
Eastman Kodak Company has defined a specific viewing environment that can be used to
unambiguously define the PCS for the purposes of producing ICC profiles.1,,2 This
reproduction viewing environment is defined to have the following characteristics:

• Luminance level is in the range of 160-640 cd/m2.
• Viewing surround is average.
• There is 0.5-1.0% viewing flare.
• The adaptive white point is specified by the chromaticity values for D50: x = 0.3457

and y = 0.3585.
• The image color values are assumed to be encoded using flareless (or flare corrected)

colorimetric measurements based on the CIE 1931 Standard Colorimetric Observer.

II. Definition of ROMM RGB

As mentioned above, several criteria were identified for selecting a desirable rendered
image color manipulation space. These criteria are all satisfied by the Reference Output
Medium Metric RGB (ROMM RGB) color space. It is defined by the color values
associated with a hypothetical additive color device having the following characteristics:

• Reference primaries defined by the CIE chromaticities given in Table 1.
• Equal amounts of the reference primaries produce a neutral with the chromaticity of

D50.
• The capability of producing a black with L* = 0.
• No cross-talk among the color channels (i.e., red output is affected only by red input,

green output is affected only by green input, and blue output is affected only by blue
input).

Table 1. Primaries/white point for Reference Output Medium.

Color x y
Red 0.7347 0.2653

Green 0.1596 0.8404
Blue 0.0366 0.0001

White 0.3457 0.3585

The primaries given in Table 1 were selected to provide a color gamut large enough to
encompass most common output devices and to minimize the introduction of hue
rotations during tone scale modifications.

Additionally, a quantization scheme must be specified to store the ROMM RGB
values in an integer form. A simple gamma function nonlinearity incorporating a slope
limit is defined for this purpose supporting 8-bit/channel, 12-bit/channel, and 16-
bit/channel quantization schemes.
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The conversion of the PCS XYZ tristimulus values to ROMM RGB values can be
performed by a matrix operation, followed by a set of 1-D functions. This is equivalent to
the operations associated with a basic CRT profile. This means that ROMM RGB can be
used conveniently in a system employing ICC profiles using an appropriately designed
monitor profile. The details of the conversion from XYZ to ROMM RGB will be
described.

II.A. ROMM RGB Conversion Matrix

Given the defined primaries shown in Table 1, it can be shown that the following
matrix can be derived to compute the linear ROMM RGB values from the PCS image
tristimulus values:
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where it is assumed that the PCS tristimulus values have been scaled so that the YPCS value
for an idealized reflection paper media is 1.0. As required by the definition of the
Reference Output Medium, image tristimulus values with the chromaticity of D50 map to
equal ROMM RGB values. It can easily be shown that a neutral with a YPCS value of 1.0
maps to linear ROMM RGB values of 1.0. Consistent with the Kodak interpretation of the
ICC profile connection space, these unity ROMM RGB values will therefore correspond
to the white point of an idealized reflection paper media.

II.B. Nonlinear Encoding of ROMM RGB

The functional form of the ROMM RGB nonlinearity is a gamma function with a
linear segment at the dark end of the intensity scale:
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where X is either R, G, or B, Imax  is the maximum integer value used for the nonlinear
encoding, and

( ) 001953.016 8.11/8.1 == −
tE    . (3)

For the baseline 8-bit configuration, Imax  is equal to 255. The linear segment of the
nonlinearity is used to impose a slope limit so as to minimize reversibility problems
because of the infinite slope of the gamma function at the zero point.
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Table 2. Sample neutral patch encodings.

Relative Intensity PCS L* ROMM8 RGB ROMM12 RGB ROMM16 RGB
0.00 0.00 0 0 0
0.001 0.90 4 66 1049
0.01 8.99 20 317 5074
0.10 37.84 71 1139 18236
0.18 49.50 98 1579 25278
0.35 65.75 142 2285 36574
0.50 76.07 174 2786 44590
0.75 89.39 217 3490 55855
1.00 100.00 255 4095 65535

A 12- and a 16-bit version of ROMM RGB are also defined. The only difference is
that the value of Imax  is set to 4095 or 65535, respectively. In cases in which it is
necessary to identify a specific precision level, the notation ROMM8 RGB, ROMM12
RGB and ROMM16 RGB is used. Table 2 shows some sample encodings for a series of
neutral patches of specified relative image intensity, where a relative image intensity of
1.0 corresponds to the white point of the PCS.

If ROMM RGB images are going to be stored in a file, then the image must be scaled
to a bit-depth supported by the file format. In many cases this will limit the image bit-
depth to the 8-bit or 16-bit encodings. In particular, for files that are to be read into
Adobe Photoshop software, it is recommended that the 8-bit or 16-bit encoding options
be used since Photoshop software supports only these bit-depths. If it is desired to store a
ROMM12 RGB image in a file format that does not support 12-bit encoding, it is
recommended that the code values first be scaled up by (65535/4095) to convert them to
ROMM16 RGB values. Alternatively, they could be scaled down by (255/4095) to
convert them to ROM8 RGB values and stored in an 8-bit file. However, the use of the 8-
bit encoding will result in a loss of precision in the image data.

One potential use of the ROMM RGB color space is as a working color space for
Adobe Photoshop software. However, it should be noted that Adobe Photoshop software
currently limits the nonlinearity that can be used to define a valid working space to be a
simple gamma function. However, both the Adobe Photoshop software implementation
and the Kodak Digital Science Color Matching Module (CMM) implementation
automatically impose a slope limit of 16 at the dark end of the tone scale. Although a
profile that explicitly incorporates the nonlinearity with the slope limit can not be used by
Adobe Photoshop software, a profile using a simple gamma function nonlinearity
produces the net effect of Eq. (2) when used by Adobe Photoshop software or the current
version of the Kodak CMM. Therefore, to ensure Adobe Photoshop software
compatibility, the ROMM RGB ICC profile created by Eastman Kodak Company uses a
simple gamma function nonlinearity without the slope limit, rather than the form shown
in Eq. (2). At some point in the future it may be possible to produce a new ICC profile
that explicitly incorporates the slope limit if Adobe were to modify the Photoshop
software to remove this artificial restriction. Although this would not have any effect on
the results obtained using Adobe Photoshop software or the Kodak CMM, it would
increase the likelihood that equivalent results would be obtained using different CMMs
that may or may not include the same slope limiting feature.
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III. Inverse of ROMM RGB Encoding

It is also necessary to define an inverse transformation to convert ROMM RGB values
back to rendered image PCS values. This can be done by simply inverting the nonlinear
function given in Eq. (2), and then applying the inverse of the matrix given in Eq. (1).

III.A. Inverse of ROMM RGB Nonlinear Encoding

The first step is to undo the nonlinear encoding of the ROMM RGB values. This will
convert the signals back to linear ROMM RGB values.
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where X ROM    
 ’  and X ROM are the nonlinear and linear ROMM RGB values, respectively,

and as before, X is either R, G, or B.

III.B. Conversion to Profile Connection Space (PCS)

To convert the ROMM RGB values to the corresponding D50 PCS tristimulus values,
it is simply necessary to multiply by the inverse of the matrix given in Eq. (1)
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As expected, when this matrix is applied to linear ROMM RGB values that are equal,
tristimulus values with the chromaticity of D50 are obtained.

IV. Conversion Between ROMM RGB and sRGB

In many cases, it will be necessary to convert ROMM RGB values to a video RGB
representation for display on a CRT. This can be accomplished by combining the
ROMM RGB to PCS transformation described in Section III with an appropriate PCS to
video RGB transformation for the CRT. Consider the special case of a CRT that responds
according to the sRGB specification. Because sRGB is defined using a D65 white point,
and the PCS is defined using a D50 white point, the first step in the conversion of PCS
values to sRGB values must be a D50-to-D65 chromatic adaptation:
















=
































−

−

=
















→

50

50

50

6550,

50

50

50

65

65

65

3200.10000.00000.0

0012.00048.10060.0

0678.00547.09845.0

D

D

D

DDA

D

D

D

D

D

D

Z

Y

X

M

Z

Y

X

Z

Y

X

   . (6)



Version 2.2 7 7/1/99

The sRGB color space is defined using the phosphor primaries associated with
Rec. 709. It can be shown that the conversion from D65 tristimulus values to the linear
RGB values associated with these primaries is given by the following inverse phosphor
matrix:
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Finally, the desired sRGB code values can be computed by applying the appropriate
nonlinearity and integerizing:
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where X is either R, G, or B. It should be noted that despite the “2.4” in the exponent of
Eq. (19), the effective gamma value associated with this nonlinearity is actually about 2.2
(where the effective gamma is determined from the slope of the straight-line portion of
the curve when the nonlinearity is plotted with logarithmic axes). This is due to the effect
of the offset term in the equation. The sRGB nonlinearity is designed to be representative
of a typical CRT found on a PC.

Conversion from ROMM RGB values to the sRGB code values can therefore be
accomplished by applying the inverse ROMM RGB nonlinearity given in Eq. (4),
followed by the matrices given in Eqs. (5), (6) and (7), followed by the sRGB nonlinearity
given in Eq. (8). The three sequential matrix operations can be combined by cascading
the matrices together to form the following single matrix:
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Thus, the transformation from ROMM RGB to sRGB can be implemented with a simple
LUT-MAT-LUT chain.

It should be noted that not all colors that can be encoded in ROMM RGB will be
within the sRGB color gamut. As a result, it will be necessary to perform some sort of
gamut mapping to clip all of the colors to the appropriate gamut. The simplest form of
gamut mapping is just to clip all of the linear sRGB values to the range 0.0 to 1.0 before
applying the nonlinearity of Eq. (8). However, this approach can result in noticeable hue
shifts in certain cases. As a result, superior results can be obtained using more
sophisticated gamut mapping strategies.

The conversion from sRGB back to ROMM RGB is simply an inverse of the steps that
were just discussed. First, the inverse of the sRGB nonlinearity given in Eq. (8) is applied
to determine the linear RGBs values:
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Next, the inverse of the matrix in Eq. (9) is used to compute the linear RGBROM values,
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Finally, the ROMM RGB nonlinearity given in Eq. (2) is applied to determine the
ROMM RGB values.

As noted above, many colors that can be represented in ROMM RGB space are
outside the gamut of sRGB. As a result, the process of mapping an image from
ROMM RGB to sRGB and back again is not lossless in general. Therefore, it should be
emphasized that, whenever possible, a video RGB color space should not be used as an
intermediate color space during the process of manipulating a ROMM RGB image.
Rather, the image manipulations should be applied to the ROMM RGB image directly,
and the ROMM RGB to sRGB transformation should be used to provide an image for
video preview purposes only.

On the other hand, if an original image is in a video RGB color space, it should be
possible to convert the image to ROMM RGB for manipulation purposes, and then
convert it back to the video RGB color space again with only minimal losses due to
quantization effects. These quantization effects can be reduced to negligible levels by
using the 12-bit or 16-bit versions of ROMM RGB. However, it should be noted that if the
manipulation process creates any color values that are outside the video RGB gamut,
these values will be clipped when the processed image is converted back to the original
color space.

V. Conclusions

A new large gamut color space known as Reference Output Medium Metric RGB
(ROMM RGB) has been defined. This color space is intended to be used for manipulating
and/or interchanging images that exist in a rendered image state.†

                                                
† For more information please contact Kevin Spaulding (spaulding@kodak.com) or Chris

Heinz (cheinz@ekbos.com).



Version 2.2 9 7/1/99

References

1. S. Gregory, R. Poe and D. Walker, “Communicating color appearance with the ICC
profile format,” in IS&T and SID’s 2nd Color Imaging Conference: Color Science,
Systems and Applications, 170-174 (1994).

2. “Interpretation of the PCS,” appendix to “Kodak ICC Profile for CMYK (SWOP)
Input,” ANSI CGATS/SC6 N 254, June 3, 1998.



Version 2.2 10 7/1/99

Appendix A: Selection of ROMM Primaries

As discussed above, a number of criteria were examined during the definition of the
ROMM RGB color spaces. This appendix will review some of these criteria that had a
direct impact on the selection of the RGB primaries.

Color Gamut Considerations

One of the requirements for the ROMM RGB color space was that it have a large
enough color gamut to encompass the colors produced by most common output devices,
while simultaneously maintaining acceptable levels of quantization errors. The primaries
for the ROMM RGB color space were chosen to enclose an experimentally determined
gamut of real world surface colors, without making the gamut any larger than necessary
in order to minimize quantization concerns. Figure A1 shows a CIE x-y chromaticity plot
illustrating the ROMM RGB color gamut, which can be seen to encompass the gamut of
real world surface colors. Also shown for comparison are the color gamuts for the sRGB
and Photoshop Wide Gamut RGB color spaces. It can be seen that the sRGB gamut
excludes large portions of the gamut of the real world surface colors. The Photoshop
Wide Gamut RGB color gamut excludes only some small portions of the real world
surface colors gamut in the saturated yellow and cyan regions. However, even though
these regions are quite small in chromaticity space, the errors are larger in a more uniform
color space, and actually correspond to some important colors, particularly in the yellows.

Fig. A1. Comparison of color gamuts.
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Effect of Applying Tone Scale Manipulations on Shadow-Highlight Series

Another requirement for the ROMM RGB color space was that it be an appropriate
color space for performing image manipulations. One of the most common types of
manipulations is to adjust the image tone scale using one-dimensional shapers applied
individually to the red, green, and blue channels of the image. Since the tone scale
functions are typically nonlinear, hue shifts can occur when a highlight to shadow series
of a given image chromaticity is mapped through the shaper. This is not a problem for
neutrals and the effect is minimal for near neutral colors, but the effect can be significant
for high chroma image colors. The reason for these hue shifts is that the nonlinear
functions cause the ratios of the RGB intensities to change. Hue shifts are particularly
problematic when they occur within a natural chroma gradient in an image. Such
gradients tend to occur when rounded surfaces are lit by a moderately directional light
source. In such situations chroma increases with distance from the specular highlight and
then decreases again as the shadows deepen while maintaining a constant hue.

Hue shift effects were studied during the process of selecting the ROMM RGB
primaries by examining a set of highlight-to-shadow series for eight color patches from
the MacBeth color checker. These patches included red, yellow green, cyan, blue,
magenta, light and dark flesh. Hue shifts in flesh tones and yellows, particularly in the
direction of green, are considered to be the most objectionable. Figure A2 illustrates the
hue shifts resulting from applying an S-shaped contrast-boosting tone scale using the
ROMM RGB primaries. The graph shows a series of vectors indicating the a*-b* shift
introduced by applying the tone scale function to each of the input colors. If the
transformation were perfectly hue-preserving, the plot would show a series of spokes
radiating out from the neutral point in the center. A similar plot for the Adobe Photoshop
Wide Gamut RGB color space is shown in Fig. A3. Inspection of these figures shows that
hue rotations for high-chroma yellows towards green are reduced in the ROMM RGB
color space relative to the default Photoshop color space. Hue shifts for the blues, cyans,
and flesh tones are also smaller for the ROMM RGB color space. With any set of
primaries, hue shifts can never be completely eliminated for all colors. The objective
when optimizing the location of the ROMM RGB primaries was to eliminate or minimize
objectionable hue shifts for important memory colors.
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Fig. A2.: Hue shifts for the ROMM RGB primaries when rendered through a contrast
boosting tone scale.

Fig. A3. Hue shifts for the default Adobe Photoshop Wide Gamut RGB primaries when
rendered through a contrast-boosting tone scale.
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Appendix B: Use of ROMM RGB as an Adobe Photoshop Software Working Space

Adobe Photoshop V5.0 software offers many new Color Management-related features
designed to help professionals produce high-quality images more effectively. Two of the
more significant new ICC features are ICC Profile Tagging and the decoupling of the
monitor definition from RGB editing space (referred to as the “RGB Working Space”).
One of the criteria for the definition of ROMM RGB was compatibility with usage as an
Adobe Photoshop V5.0 software RGB Working Space. This appendix presents guidelines
for how ROMM RGB can be used for this purpose in practice.

RGB Working Spaces

One of the objectives of the Adobe Photoshop V5.0 software CMS architecture is to
allow multiple systems with different monitor spaces to view the same image accurately,
without data conversion. To facilitate this, RGB color space editing is now independent
from the workstation-specific (device dependent) monitor definition. This capability
provides a color managed display image in video RGB while maintaining the ability to
store the actual image in the larger color gamut workspace.

The RGB Working Space must be a simple, idealized color space that can be
completely defined in terms of a single gamma, white point, and phosphor set. Kodak’s
provision for compatibility of the ROMM RGB with the Photoshop software’s RGB
Working Space requirements opens up a practical avenue for deployment of ROMM RGB
as an intermediate processing and transfer space to facilitate ICC production methods. As
a result, ROMM RGB serves as a convenient storage, edit, archive, and transfer color
space for many professional imaging applications.

ICC Profile Tagging

ICC Profile Tagging is the linchpin that will hold together and help automate digital
imaging processes in the future. In this scheme, TIFF and EPS images contain a profile
that converts from the mode-specific color space to the ICC Profile Connection Space
(PCS)—usually LAB. Specifically, ROMM RGB images can be tagged with a
ROMM RGB Working Space profile, and then can be interpreted unambiguously in
conforming processes downstream.

The combination of these two features—RGB Working Spaces and ICC Profile
Tagging—make device-independent editing methods possible for the first time. Device-
independent image editing is highly recommended for sites that plan to store and re-
purpose digital image assets. Ultimately, it is anticipated that full-gamut editing will
become “coin of the realm” and will continue to gradually displace (or reduce the need
for) device-specific RGB and CMYK editing in all but specialty applications.

Creating an RGB Working Space

There are two ways to establish ROMM RGB as a working space:

(1) Load the Kodak-supplied ROMM RGB profile (if available)
(2) Enter the corresponding ROMM RGB parameters.

When a ROMM RGB ICC profile is available, it can be used to define the RGB Working
Space in the following manner. First, select the File>Color Settings>RGB Setup Menu
option:



Version 2.2 14 7/1/99

Fig. E1. Dialog box for File>Color Settings>RGB Setup Menu option.

To load the supplied ROMM RGB profile, simply select the “Load...” option.
Navigate to the appropriate profiles directory, and select the ROMM RGB profile. The
Photoshop software then reads the attributes necessary to activate the profile as a
Working Space. The default directory for storing ICC profiles will be a function of the
operating system:

• Macintosh OS: System>Preferences>ColorSync* Profiles
• Macintosh OS, with Colorsync 2.5 or higher: System>ColorSync* Profiles
• Windows 95, Windows 98: Windows>System>Color
• Windows NT4.x: Winnt>System32>Color

If a ROMM RGB ICC profile is not present, it is necessary to enter the ROMM RGB
parameters via the RGB Setup dialog, as follows:

• Set Gamma to: 1.80
• Set White Point to: 5000 K (D50)
• Set custom x-y primaries for Red, Green, and Blue to:

Color x y
Red 0.7347 0.2653

Green 0.1596 0.8404
Blue 0.0366 0.00010

After these parameters are entered, select “Save...” to create an ICC profile, and store
the profile in the default profiles directory. This allows plug-ins and other ICC-
compatible applications to create and interpret ROMM RGB encoded imagery.

Note: saving the ROMM RGB profile is also useful if the RGB Working Space is changed
from ROMM RGB. In this case, ROMM RGB can be re-established as the RGB Working
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Space by choosing “Load…” from RGB Setup dialog box, and selecting the ROMM RGB
profile.

Display Using Monitor Compensation must be selected when working in
ROMM RGB. An accurate Monitor Profile is necessary to establish the proper
screen display of the ROMM RGB image.  Selecting this  option converts the
ROMM RGB image to Monitor RGB dynamically in the display path, using the
following pair of profiles:

(1)  ROMM RGB Profile - converts ROMM RGB to XYZ
(2) Monitor Profile – converts XYZ to monitor RGB.

An accurate monitor profile is necessary to establish the proper screen display of
the ROMM RGB image. Kodak’s monitor profiling product, Kodak Colorflow
ICC monitor profile builder, works with the Xrite DTP92 monitor colorimeter to
build an objective, instrument-based monitor profile for Macintosh and
Windows platforms. Other ICC vendors have similar products. Refer to the user
guide for techniques to build the best possible monitor profile.

Activating a monitor profile on the Macintosh

The monitor profile is established in the Colorsync Control Panel.  Verify this
by reading the profile description in the Control Panel, and ensuring that the
same text string displays next to the “Display using Monitor Compensation”
clickbox. If Photoshop software is running, it is not necessary to quit the
application and re-launch to recognize the new Control Panel selection. The new
selection is honored by the RGB Setup menu.

Please contact Kodak’s Colorflow technical support center for more
information about activating monitor profiles that have been tuned in Colorflow
profile editor.

Activating a monitor profile on Windows 95

With the Kodak Colorflow ICC monitor profile builder, the application offers
an option to set the monitor profile builder profile as the Photoshop 5 software
default.

Alternatively, the monitor profile can be designated using the Adobe Gamma
control panel. (Note: This procedure must be used for OEM or default monitor profiles.)

• Choose the Control Panel version of the program (the other version is a step-by-
step visual calibration).

• Select the monitor profile and choose OK. A message appears: "Do you want to
save changes to profile xxxxx". To get the profile to appear in the RGB Setup
menu in Photoshop software V5.0, the answer has to be “yes.”

(Note: Among the changes made are that the Copyright becomes Adobe Systems
Inc., and any LUTs and multi-point TRCs are reduced to a single value TRC.
This procedure can lose certain profile characteristics for custom-tuned monitor
profiles.) Please contact Kodak’s Colorflow technical support center for more
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information about activating monitor profiles that have been tuned in Colorflow
profile editor.

Activating a monitor profile on Windows 98

For Win98, first install the new monitor profile into ICM. This is done using
the Display Control Panel. Use the Settings menu in that Control Panel and click
on “Advanced....” to bring up a series of tabs that include a ColorManagement
selection. Within here, a user can add monitor profiles to be associated with that
card, and also identify a default profile. A profile needs to be on this list before
Adobe Gamma will save it as a choice as the system monitor.

Once the system monitor profile is defined by one of the means above, the
RGB Setup menu in Photoshop software will show this monitor profile as the
monitor used to display through if the "Display with Monitor Compensation" is
checked. Note that the profile description is used to identify the profile, so care
should be taken to name the internal description with a suitable string.

Any editing done to the profile in Colorflow profile editor will be compromised
by loading into Adobe Gamma as it will be changed to a single value. Please
contact Kodak’s Colorflow technical support center for more information about
activating monitor profiles that have been tuned in Colorflow profile editor.

Fig. E2. Dialog box for File>Color Preferences>Profile Setup Menu option.
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Saving ROMM RGB Images with a Profile Tag

To enable the embedding of RGB profiles in images, choose the “File>Color
Preferences>Profile Setup” menu option. and select the settings shown in Fig. E2. RGB
images must be tagged with the RGB Working Space profile to set up correct use upon
re-open. Working in ROMM RGB, and tagging with the ROMM RGB profile, sets up the
most flexible re-use in the future.

Note: profile tagging also allows use of the ICC output conversion process available in
applications such as Page Layout, OPI Server, and PS RIP. This is more flexible than
converting to an output-specific color space at the capture stage or inside Photoshop
software.

Verifying the ROMM RGB Working Space

The following procedure can be used to verify that the ROMM RGB Working Space is
being used correctly.

• Set the Profile Mismatch handling, in “File>Color Settings>Profile Setup” as show in
Fig. E2. Setting the Mismatch handling to “Ask When Opening” will cause the Open
command to pause and query the user when the image is tagged differently than the
current Working Space.

• For example, open the Bottles image that is installed with Adobe V5.0 software, in the
Photoshop application folder>Goodies>Samples. The Bottles image was tagged as
sRGB. When the Open command checks the Working Space and finds ROMM RGB
(something other than sRGB), the user is presented with the following dialog:

Fig. E3. Profile Mismatch Dialog Box.
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• Convert is the default option and would be the usual selection in order to bring images
from various sources into the common RGB Working Space, ROMM RGB in this
example. (Although Adobe attempted to create a bullet-proof user interface, it is possible
to work around the Adobe conventions, and either convert improperly or improperly not
convert.) Go ahead and select Convert.

• Save the image as Bottles.ROMM. The profile is now tagged to the image.

• Open the Bottles.ROMM image once more. Now, there should be no Profile Mismatch
message.

• Open the original Bottles image again. This time, answer “Don’t Convert” for testing
purposes. The image will contain sRGB data but will display as if it is ROMM RGB, so
the image will appear over-saturated. Open the RGB Setup dialog, and turn off “Display
using Monitor Compensation” temporarily. The image will appear less saturated (closer
to proper display, since sRGB is a monitor definition). Close the dialog.

• Select the Bottles.ROMM image. The image will look desaturated relative to the sRGB
image when “Display using Monitor Compensation” is turned OFF.

• Turn on “Display using Monitor Compensation” to display the image properly. Notice
that the original Bottles image is now over-saturated relative to the correctly displayed
Bottles.ROMM image.

• Close the Bottles image without saving it. (If it were saved, the ROMM RGB profile
would be improperly tagged to the image in place of the sRGB tag.)

Troubleshooting Tips:

• If an image looks over-saturated on screen, then it’s possible that a monitor-like RGB
image was not converted to ROMM RGB upon open.

• If an image looks desaturated on screen then “Display using Monitor Compensation”
might be turned OFF (it should be ON when using ROMM RGB as the Working Space).

• If an image looks desaturated on output then the ROMM RGB image might not have
been converted to the output-specific color space (either within the Photoshop software or
via an ICC-aware page layout or output system).

Opening Images and Converting to ROMM RGB Working Space

• PHOTO CD Open File Format Plugin

The Kodak ICC PHOTO CD Open file format plug-in is ICC-compatible. The Source
is a PHOTO CD input profile, while the destination can be LAB, CMYK, monitor RGB,
or output RGB.

Direct ICC conversion to a destination device color space is still available and useful
within Adobe V5.0 software. However, using the RGB Working Space as a Destination
profile is preferred. The procedure is as follows:
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(1) If you don’t already have a ROMM RGB ICC profile, create an ICC profile by
selecting Save.. from the RGB Setup dialog box.

(2) In the Open dialog, select the PHOTO CD input profile as Source profile (as
usual). Select the ROMM RGB working space ICC profile as destination.

(3) Edit the image if needed
(4) Save the image to disk (ROMM RGB Working Space profile is embedded).

• Use of Non-ICC Acquire Modules

Input devices such as Kodak digital cameras and film scanners ship with Acquire
plug-ins for the Adobe Photoshop software. These plug-ins are compatible with Adobe
V5.0 software, even though they are not ICC-aware. There are a few user techniques that
will aid the transition to Photoshop V5.0 software.

The most effective procedure is to convert from the input RGB to the RGB Working
Space upon Open, by selecting Image>Mode> Profile to Profile. Select the custom input
profile as the Source, and select the RGB Working Space profile as the Destination. (It is
possible to build an Action that can be triggered at the touch of a function key to call the
appropriate Action for the given source device.)

An alternative method is to set the custom input profile as the Assumed Profile for
RGB images. This is convenient because the Profile Setup dialog can be set to apply the
assumed profile upon open, in cases where the image is not already tagged. With this
method, the conversion also utilizes the custom input profile as Source, and the RGB
Working Space as Destination. However, if an image from another source (such as a
different scanner, or digital camera) is opened, this image will be (incorrectly) converted.
In summary, this approach is fine for single-source workstations, but is not recommended
for general use.

• Opening Legacy Files

If an RGB image is “origin unknown”, the normal procedure is to determine whether
it came from a PC or Macintosh platform if possible. If it came from a PC, it is usually
reasonable to convert from sRGB to the ROMM RGB Working Space. If it came from a
Macintosh, it is reasonable to convert from Colormatch to the ROMM RGB Working
Space.

If an image was originally stored in a monitor RGB space such as Colormatch, there
will generally be some saturated colors that were clipped or compressed into the original
monitor gamut. Therefore, this method should be considered to be “best efforts” only and
is not necessarily optimal. The good news is that nothing will be lost by interchanging in
and out of ROMM RGB during subsequent conversions.

Legacy CMYK files can also be re-expressed in alternate color spaces if an output
profile is available that is representative of the site’s output process. (Unfortunately, the
result would include some gamut compression from having been stored in CMYK, but
this approach can still be useful in many cases.) An Action can be established to Open a
folder of CMYK images, convert from CMYK to ROMM RGB, and Save each image as a
tagged ROMM RGB Tiff file.
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Opening ROMM RGB Images

In order to exchange image files properly among workstations, all should be set up
with the same profile preferences so that ROMM RGB images are not converted
inadvertently. Specifically, ROMM RGB should be set as the Working Space, and profile
embedding should be turned on for the saving of an RGB image.

This procedure avoids excessive conversions. If the tag equals the Working Space, no
conversion is performed. Aside from converting legacy images to ROMM RGB upon
Open, or converting images acquired from non-ICC devices, there is no reason to convert
upon open. In particular, avoid exchanging images with a workstation that is not set to
ROMM RGB because it will be needlessly converted there to a smaller gamut image –
which defeats the purpose of adopting full gamut ROMM RGB editing.

ROMM RGB images can be created using an off-line process (e.g., KODAK
COLORFLOW Image Server), or using another workstation with Photoshop software.
The tagging protocol in Image Server V1.1 will conform to Adobe Photoshop V5.0
software, so that the Server can be used as a 100% compatible feeder to the Photoshop
software.

Editing ROMM RGB Images

RGB mode in Adobe Photoshop V5.0 software offers 16-bit editing. This makes it
possible to make a major tone move while in 16 bit mode with minimal artifacts. If the
image is originally in an 8-bit image encoding, the 8-bit image can be mode changed to
16-bit in order to apply the Image adjust moves, then dropped back to 8-bit for final
adjustments and output. The effect on the image data can be observed by comparing
histograms of an image adjusted in 8-bit mode to that of an image adjusted in 16-bit
mode.

Edits are possible while viewing the image in full gamut or with respect to output.
While viewing and editing in full gamut, edits can be made without regard for the specific
output process; this is equivalent to establishing the desired color appearance of the
image (in ICC terms).

Alternatively, while viewing in Output Simulation, preferred reproduction
characteristics can be imparted to an image that take into account the color gamut
available for the chosen output process. Note: When storage and edit of the image in a
device space is necessary, it is advisable to archive the device independent image prior to
conversion.

ICC Soft Proof Filter

With Photoshop V5.0 software, accurate monitor viewing is finally in place for most
image reproduction applications. RGB output simulations are the notable exception. The
lack of support for viewing RGB simulations in the Photoshop V5.0 software suggests
the use of Kodak ColorFlow ICC soft proof filters for certain applications.

Specifically, images that are in ROMM RGB but are intended for an RGB Output
process (such as Durst Lambda), or images that have already been converted to an Output
RGB color space, can be viewed properly with the help of the Soft Proof filter. (Note:
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ICC Soft Proof is available for Macintosh only; a recent patch provides compatibility
with OS 8.5.)

The editing of ROMM RGB images is possible in 8-bit or 16-bit depth. Although most
filters are not available for use on 16 bit images, ICC Soft Proof is an exception. The Soft
Proof filter is a toggle filter that operates on the contents of the graphics display buffer, so
it remains active for 16-bit images that are displayed (although it must first be activated
while an 8 bit image is displayed).

Printing ROMM RGB Images from Photoshop software

It would be ideal to maintain a single RGB file and convert the data while printing to
different output devices. However, in Adobe Photoshop V5.0 software, you lose the
flexibility of controlling rendering intent and color matching engine when the ICC
conversion is invoked at print time.

Also, the printer color management checkbox doesn’t control whether your printer
uses color management or not, but only whether PS5 embeds color information
describing your RGB work space in the stream of data sent to the print driver. It is
unclear whether ICC profiles are being directly stored or whether they are being
converted to CRDs, for use with PS Level 2 RIPS or higher. In either case, a non-
compliant printer might show no conversion, or supersede it with an arbitrary “printer’s
default” conversion.

In summary: conversion at print time is still a risky business, but may be useful for
closed-loop systems. Contact your printer vendor to establish the degree of PS5 and
ICC/CRD compliance of a particular model.

A tried and true method is to convert the pixels to output device color space via a
Profile to Profile command. Again, the use of a canned Action is suggested. In this case,
it is especially important to avoid over-writing the ROMM RGB image with transient
device data. For example:

(1) Select Profile to Profile to convert from ROMM RGB Working Space to XLS
8650 RGB, and print.

(2) Close the image without saving, to maintain the ROMM RGB image. Re-open the
ROMM RGB image if additional output-specific images are needed.

Use of Tagged ROMM RGB images in other applications

If Adobe Photoshop V5.0 software is viewed in isolation, the tagging features are
sufficient to allow proper saving and opening of ROMM RGB images. A standardized
tagging mechanism allows a digital image to be transported to different applications and
platforms without ambiguity about its origin. Additional application upgrades will
emerge, that recognize and act upon the profile tag properly. Specifically, an ICC tagging
compliant application will be able to use the tagged profile as Source, while supplying the
Destination profile (monitor or output for example) to complete the reproduction chain.

In the next 6-12 months there will be very few applications other than the Photoshop
software that are fully ICC-compliant, especially with the flavor of tagging introduced in
Adobe Photoshop V5.0 software. Therefore, an alternative working space may be useful
in conditions where a workstation downstream may not have Adobe Photoshop V5.0
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software. If the ultimate user of the image data will NOT be using a color-managed
application to convert the data to output-specific data, then the output will generally not
be printed properly, and will typically be quite desaturated because of the encoding in the
ROMM RGB Working Space. A Working Space such as Adobe RGB 98 may be more
effective under this circumstance (note: V5.02 of the Photoshop software introduced
Adobe RGB 98 as an additional Working Space). At minimum, take steps to ensure that
the application is compatible with images created with a tagged RGB Working Space.

Bit Depth for ROMM RGB Working Space

An important consideration relative to the “editability” of an image in the ROMM
RGB Working Space is the bit depth. RGB Working Spaces in the Photoshop software
offer both 8-bit and 16-bit modes. (As discussed above, it is generally recommended that
ROMM12 RGB images be converted to a 16-bit encoding when stored in a file that is to
be read into Adobe Photoshop software.) Where possible, the 16-bit Working Space
should be maintained in the Photoshop software for the manipulation of ROMM16 RGB
images. In some cases it will be desirable to use the 16-bit Working Space option even
for the manipulation of ROMM8 RGB images. This makes it possible to apply more
aggressive image adjustments to an image with the minimal introduction of artifacts. The
recommended approach for the most discerning color imaging professional is to make all
major color appearance adjustments while in 16-bit ROMM RGB Working Space, then
only drop back to 8-bit for any final fine tuning and specific “output preparation”
adjustments.

Kodak, ColorFlow, PHOTO CD and PhotoYCC are trademarks of Eastman Kodak
Company.


